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ZUSAMMENFASSUNG 

 

Zur kiefergelenkfunktionsabhängigen Knochendicke zwischen Fossa mandibularis des 
Os temporale und der Fossa cranii media 

  

Arndt, Christian 

 

Das Kiefergelenk (Articulatio temporomandibularis) nimmt aufgrund seiner speziellen 
Morphologie eine besondere Stellung unter den Gelenken ein. Für alle Disziplinen der 
Zahnheilkunde ist es von großem Interesse, wie sich das Gelenk auf funktionelle Einflüsse hin 
verhält. Stellvertretend für die Adaptationsvorgänge des Gelenkes wird die Knochendicke 
zwischen Fossa mandibularis und der Fossa cranii media vermessen und auf Abhängigkeiten 
überprüft. Anhand der frei zugänglichen Bildbearbeitungssoftware ImageJ wurde eine Methode 
entwickelt, mit der sich das Dach der Fossa mandibularis an seiner dünnsten Stelle 
(roofthickness) anhand von Computertomographie-Datensätzen lokalisieren und vermessen 
lässt. Regeln wurden aufgestellt um ein konstantes Verfahren zu ermöglichen. Das 
Patientenkollektiv enthielt 219 männliche und 232 weibliche Gelenke. Diese wurden je nach 
Befund in drei Gruppen eingeteilt. 49 Gelenke zeigten resorptive Veränderungen und wurden 
der Gruppe „resorption“ zugeteilt. Sklerosierugen traten bei 20 Gelenken auf. Sie bildeten die 
Befundgruppe „sclerosis“. Den beiden genannten Gruppen wurde die Kontrollgruppe 
„control“ mit 382 Gelenken gegenübergestellt. Sie zeigten keinerlei pathologische 
Kiefergelenksveränderungen. Die Reliabilität der Z-Project Methode wurde durch einen Intra- 
und Interobserver anhand von 20 zufällig ausgewählten Gelenken überprüft. Die 
intraindividuelle Reproduktion betrug 93,7%, die interindividuelle Reproduktion 91,6%. Zur 
roofthickness konnte eine signifikante Abhängigkeit von der Gelenkseite herausgestellt werden. 
Abhängigkeiten zwischen dem Alter, dem Geschlecht und den Befundgruppen konnten nicht 
nachgewiesen werden. Die durchschnittliche roofthickness der Studie beträgt 3,2 mm ± 1,5. 
Das Werteintervall erstreckt sich von 0 mm bis 8,5 mm. Zusätzlich wurden Gelenke mit 
Lufteinschlüssen innerhalb des Daches der Fossa mandibularis, über deren Ätiologie in 
verschiedenen Arbeiten spekuliert wird, in vier Gruppen „none“, „poor“, „moderate“, und 
„considerable“ nach dem Ausmaß ihrer Pneumatisationen eingeteilt. 
 
Aus den ausgewerteten Daten lassen sich nachstehende Schlussfolgerungen ziehen: 
Die Z-Project Methode hat sich als ein sehr reliables Verfahren zur Ermittlung der roofthickness 
bewährt. Eine Ermittlung absoluter Werte ist mit dieser Methode jedoch nicht möglich. Sie 
müssen zunächst relativ interpretiert und dann in Verbindung mit der Literatur ausgewertet 
werden. Zur roofthickness in Verbindung mit dem Alter, dem Geschlecht und der 
Befundgruppen konnten die Ergebnisse vorausgegangener Studien untermauert werden. Neue 
Erkenntnisse ergaben sich zur Abhängigkeit der roofthickness von der Gelenkseite. Zudem 
konnte tendenziell gezeigt werden, dass das Kiefergelenk auf funktionelle Einflüsse mit der 
Bildung von pneumatisiertem Knochen reagiert.  
 
Tag der mündlichen Prüfung: 26.09.2008 
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1. Einleitung 

 

1.1 Kiefergelenk 

 

1.1.1 Morphologie und Topographie des Kiefergelenke s 

 

Das Kiefergelenk (Articulatio temporomandibularis) ist die gelenkige Verbindung 

des Unterkiefers mit der Schädelbasis. Auf dieses Gelenk wirken zwischen 50-

80 kp ein. Es ist daher das Gelenk, das im menschlichen Körper der größten 

Belastung ausgesetzt ist. Die Gelenkflächen, die Facies articularis, werden 

gebildet aus dem walzenartigen Gelenkskopf, dem Caput mandibulae, der sich 

am Ende des Processus condylaris befindet, der Fossa mandibularis des pars 

squamosa (Os temporale) und dem, nach ventral liegenden, im Querschnitt 

dornartigen Tuberculum articulare. Die gesamte Facies articularis ist mit 

faserigem Knorpel überzogen. Die beiden Gelenkköpfe sind so angeordnet, 

dass sie in ihrer Verlängerung einen nach ventral, offenen Winkel von circa 

150° ergeben. Im Sagittalschnitt, bildet die Gelenk fläche aus Fossa 

mandibularis und Tuberculum articulare eine S-förmige Gelenkbahn.  

 

Das Kiefergelenk wird nach dorsal durch eine dünne Knochenlamelle des Os 

tympanicum vom äußeren Gehörgang (Meatus acusticus externus) separiert. In 

diesem Bereich verlaufen die Arteria temporalis superficialis sowie der Nervus 

auriculotemporalis, des Nervus trigeminus benachbart zum Kiefergelenk. Medial 

zieht sich die Fissura petrotympanica mit den Chorda tympani entlang. Nach 

cranial wird das Gelenk durch ein dünnes Knochendach von der mittleren 

Schädelgrube und somit vom Gehirn getrennt.  

 

Die hohe Bewegungsfreiheit dieses Gelenks ist durch das unausgeglichene 

Größenverhältnis zwischen Gelenkspfanne und Gelenkskopf von circa drei zu 
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eins zu erklären. Die daraus entstehende Inkongruenz wird durch eine gelartige 

Struktur, dem Diskus articularis ausgeglichen. Er teilt den Gelenkraum somit in 

einen oberen und in einen unteren Gelenkspalt auf. Der ovoid gestaltete Diskus 

besteht zu seinem Großteil aus straffem Bindegewebe und enthält keinerlei 

Gefäße. Im Bereich der Randzonen findet man zudem Knorpelanteile, im 

Besonderen dort, wo er dem Kondylus in Ruhelage direkt aufliegt.  

 

Dorsal liegt dem Diskus die bilaminäre Zone an. Sie besteht aus lockerem, 

gefäß- und nervenreichem Bindegewebe. Unter anderem beschränkt sie die 

obere sowie die untere Gelenkkammer und wird als hinterer Teil der unten 

erwähnten Kapsel gesehen.  

 

 
Abbildung 1.1: Sagittalschnitt durch ein präpariert es Kiefergelenk [40] 

(1. Meatus acusticus externus; 2. Cartilago articul aris proc. Condylaris; 3. Proc. 

Condylaris mandibulae; 4. Proc. Styloideus; 5. Foss a mandibularis; 6. Discus articularis; 

7. Tuberculum articulare; 8. Os zygomaticum; 9. Pro c. Coronoideus; 10. Lig. 

Stylomandibulare).  
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Das Gelenk wird von einer sehr lockeren trichterförmigen Kapsel umgeben, die 

dem Kondylus seine hohe Beweglichkeit bewahrt. Sie zieht vom Rand der 

Fossa mandibularis nach kaudal bis zum Unterkieferhals. Nach ventral umgibt 

sie das Tuberculum articulare. Des Weiteren setzt sie am Diskus an und teilt 

somit zusammen mit ihm die diskotemporale von der diskomandibulären 

Kammer ab. In diesen Kammern befindet sich Gelenkflüssigkeit, die Synovia. 

Sie wird vom Stratum synoviale der Kapsel produziert und dient der 

Vitalerhaltung der Gelenkstrukturen. Weiter verstärkt wird das Kiefergelenk 

durch das Ligamentum laterale, das Lig. sphenoidale und das Lig. 

stylomandibulare. Arteriell wird das Kiefergelenk durch die A. auricularis 

profunda versorgt. Sie entspringt aus der A. maxillaris. Das venöse Blut wird 

über die V. articulares in die V. retromandibularis abgeleitet. Das Kiefergelenk 

ist außerordentlich gut innerviert. Sensible Nervenäste entspringen den N. 

auriculotemporalis, dem N. massetericus, den N. temporialis profundus 

posterior und dem N. facialis [43, 47, 55].  

 

1.1.2 Mechanik des Kiefergelenkes 

 

Wie bereits erwähnt, teilt der Diskus den Gelenkraum in ein oberes, 

diskotemporales und ein unteres, diskomandibuläres Gelenk auf. Dem 

Unterkiefer werden durch das obere Gelenk Gleitbewegungen und durch das 

untere Gelenk Scharnierbewegungen erlaubt. 

 

Es ergeben sich insgesamt drei Bewegungsmöglichkeiten: 

 

1. Öffnungs- und Schließbewegungen (Abduktion und Adduktion) 

2.  Vor- und Zurückschieben (Protrusion und Retrusion) 

3.  Seitwärtsbewegungen (Medio- und Laterotrusion) 

 

Für die Abduktionsbewegungen sind der Musculus pterygoideus lateralis und 

die Mundbodenmuskulatur bei festgestelltem Zungenbein relevant. Die 
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Adduktion wird durch den M. masseter, den M. temporalis und den M. 

pterygoideus medialis bewirkt. Soll der Unterkiefer protrudiert werden, 

kontrahieren die Muskelfasern des M. ptyerigoideus lateralis sowie 

unterstützend die oberflächlichen Anteile des M. masseter und des M. 

ptyerigoideus medialis. Kontrahiert der M. ptyerigoideus lateralis einseitig, 

weicht der Unterkiefer zur Gegenseite ab. Retrudiert wird der Unterkiefer durch 

die Kontraktion der hinteren Anteile des M. temporalis und durch die 

Kontraktion der Mundbodenmuskulatur. 

 

 
Abbildung 1.2: Sagittalschnitt durch ein geöffnetes  Kiefergelenk [47].  

 

Die Öffnungsbewegung des Unterkiefers erfolgt initial durch eine reine 

Scharnierbewegung. Ab einer Schneidekantendistanz von durchschnittlich 

15mm kommt zu der Rotationsbewegung um die Kondylenachse eine 

Protrusionsbewegung hinzu. Diese Bewegungen werden ohne Artikulation 

ausgeführt, wohingegen bei Protrusions-, Retrusions- und Seitwärts-

bewegungen die Zahnreihen die Unterkieferbewegungen führen. Das Kiefer-

gelenk gilt als ein multifaktorielles System. Dabei sind die Anatomie der Gelenk-
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flächen, die Gebisssituation, und die Kaumuskulatur von größter Bedeutung. 

Liegt eine Störung innerhalb dieser Teilbereiche vor, so kann es zu 

Funktionsstörungen des gesamten Kauorgans kommen [43, 44, 55]. 
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1.1.3 Anpassungsvorgänge im Kiefergelenk 

 

Die postnatale Entwicklung des Unterkiefers ist in der Regel mit dem 20. 

Lebensjahr abgeschlossen. Dabei stoppt das transversale Wachstum des 

Kiefers zuerst im Alter von 10-12 Jahren, gefolgt vom sagittalen Wachstum mit 

12-14 Jahren. Das vertikale Wachstum kann in Ausnahmefällen sogar das 20. 

Lebensjahr überschreiten. Das Kiefergelenk unterliegt jedoch auch nach dem 

Abschluss des Unterkieferwachstums, durch eine Vielzahl von funktionellen, 

parafunktionellen oder auch traumatischen Faktoren zahlreichen Adaptations-

vorgängen. Diese Adaptationsvorgänge können sich zum Beispiel in ihrer 

progressiven Form (modeling) durch Neubildung von Bindegewebe oder 

kompensatorisch durch eine muskuläre Reaktion äußern. Sind die Einflüsse auf 

das Kiefergelenk zu stark oder ist die Adaptationsfähigkeit herabgesetzt, kommt 

es zu regressiven Adaptationen (remodeling) oder Dekompensationen. Diese 

äußern sich meist in Form von Destruktionen und Schmerz. Generell ist zu 

sagen, dass mit dem Alter die Adaptationsfähigkeit des Kiefergelenkes abnimmt, 

und dass Adaptationsvorgänge nach Wachstumsabschluss vorwiegend 

regressiv sind.  

 

Speziell im Hinblick auf Stellungsanomalien von Zähnen bzw. fehlende Zähne 

und Kieferdysgnathien wurden reaktive Umbauvorgänge im Bereich des 

Kiefergelenks dokumentiert [16, 32, 43, 55].  

 

1.1.3.1 Wachstumsverhalten des Kondylus 

 

Im Rahmen von kieferorthopädischen Therapien beschäftigt sich die 

Wissenschaft unter anderem mit dem Wachstum der Fossa mandibularis und 

dem in ihr liegenden Kondylus.  

 

Es wurde in mehreren unabhängigen Studien an Menschen und Tieren 

versucht, das Wachstumsverhalten des Kiefergelenks durch die Therapie mit 
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kieferorthopädischen Geräten (Herbst und Twin-Block) zu beeinflussen. Diese 

Geräte werden in der Praxis dazu verwendet, eine mandibuläre Retrognathie 

durch gezielte Wachstumsstimulation zu korrigieren.  

 

Verschiedene Studien zu diesem Thema besagen, dass sich die 

Wachstumsrichtung des Kondylus bei Patienten, die kein Herbstscharnier 

tragen, hauptsächlich nach superior und marginal nach posterior richtet. 

Patienten, die in Studien ein Herbstscharnier getragen haben, zeigten ein 

generell erhöhtes Kondyluswachstum, wobei sich das Wachstum vor allem 

nach posterior orientierte [37, 42]. Im Anschluss an die Therapie konnte dieses 

Wachstumsverhalten nur noch in abgeschwächter Form beobachtet werden [42, 

53]. Statistisch gesehen, kommt demnach das durch das Herbstscharnier 

geförderte Kondyluswachstum ein dreiviertel Jahr nach Therapieabschluss zum 

Stillstand und nimmt wieder die prätherapeutische Richtung und das 

prätherapeutische Ausmaß an [6, 35, 36, 37].  

 

Nach Meinung der Autoren lässt sich daraus schließen, dass das 

Kondyluswachstum nur temporär durch die kieferorthopädische Behandlung mit 

einem Herbstscharnier oder Twin-Block in eine superiore und posteriore 

Richtung stimuliert werden kann. Folglich wird der Effekt dieser kiefer-

orthopädischen Geräte für Langzeittherapien durch die Autoren in Frage gestellt. 

[42, 53, 37, 6, 18].  

 

In weiterführenden Studien wird angeführt, dass das kondyläre Wachstums-

potential vom Alter abhängig ist [9, 28, 53, 57]. Auf der einen Seite konnte 

nachgewiesen werden, dass das Wachstum bei erwachsenen Versuchstieren 

ein deutlich geringeres Ausmaß annimmt als vergleichsweise das der 

heranwachsenden Tiere [17, 30]. Andere Studien bestätigen dies nicht. Sie 

besagen, dass die Behandlung mit einem Herbstscharnier durchaus noch nach 

abgeschlossenem Wachstum effizient ist [12, 31, 40].  
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Über den Aufbau des Kondylus (Abb. 1.3) kann man das Kondyluswachstum 

veranschaulichen. Die Artikulationsfläche des Kondylus ist mit einem gering 

durchbluteten, zellreichen Bindegewebe überzogen. Direkt darunter findet man 

die Proliferationszone, bestehend aus praechondroblastischen Zellen die sich 

nach und nach zu Chondroblasten differenzieren. Diese Zone ist für die 

Ernährung und die Bildung des Knorpels von großer Bedeutung. Es folgt die 

Schicht des heranreifenden Knorpels. Sie besteht aus ungeordneten 

Chondroblasten und hypertrophierten Zellen, deren Matrix zunehmend 

kalzifiziert. Eine Schicht tiefer wird die enchondrale Ossifikation vollendet. 

Knorpelige Bestandteile werden resorbiert und durch knöcherne ersetzt. 

 

 
Abbildung 1.3: Skizze des histologischen Aufbaus ei nes Kondylus. a=Artikluationsfläche 

aus zellreichem Bindegewbe; b=Schicht mit praechond roblastischen Zellen; c=Schicht 

des reifenden Knorpels; d=endochondraler Knochen [1 0]. 
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1.1.3.2 Ursachen des Wachstumsverhaltens 

 

Die Ursachen des kondylären Wachstumsverhaltens werden mit unter-

schiedlichen Erklärungen diskutiert. VOUDOURIS betrachtet in seiner Veröffent-

lichung verschiedene Hypothesen. Er untersucht,  wie es unter kieferortho-

pädischer Therapie mit einem Herbst- oder Twin-Block zu Modifikationen im 

Bereich des Kiefergelenks kommt [52].  

 

MASSLER behauptet im Jahre 1944 originär, dass das Kondyluswachstum 

strengen genetischen Faktoren unterliegt und mit dem Wachstum einer 

Epiphyse zu vergleichen ist [52]. Das hieße aber auch, dass Modifikationen 

nach Wachstumsabschluss nicht mehr möglich seien und somit die Effizienz 

kieferorthopädischer Behandlung zu diesem Zeitpunkt in Frage gestellt würde. 

MCNAMARA und BRYAN verwerfen in ihrer Arbeit diese Hypothese [29].  

 

Eine zweite Hypothese, die vor allem von PETROVIC [39] und MCNAMARA [28] 

vorangetrieben wurde, orientiert sich an der Kaumuskulatur. Die Kaumuskulatur, 

die mit der Gelenkregion verbunden ist, soll demnach das Kondyluswachstum 

beeinflussen. Die Autoren diskutieren mehrfach eine Hyperaktivität des 

Musculus pterygoideus lateralis [34, 45, 46, 49, 56]. 

 

In den fünfziger Jahren vermutete REES, dass verschiedene Kaumuskeln 

direkte Ansätze am Kondylenkopf und am Diskus haben und somit direkt auf 

den Kondylus einwirken können. Seine Vermutungen konnten jedoch durch 

Autopsiematerial nicht verifiziert werden. Man wies lediglich Verbindungen zur 

vorderen Kapsel und zum Diskus nach [52]. 

 

Andere Untersuchtungen ergaben konträr, dass das kondyläre Wachstum nicht 

mit einer gesteigerten, sondern mit einer verringerten Kaumuskelaktivität 

korreliert [24, 46, 56]. Auch WHETTEN konnte in seiner Arbeit keinen signi-

fikanten Wachstumsunterschied des Kondylus zwischen Gelenken mit resizier-
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tem Musculus pterygoideus lateralis und den Gelenken der Kontrollgruppe 

nachweisen [56]. 

 

Die „functional matrix theory“, macht das umliegende Weichgewebe und nicht 

den Knochen selber für sein Wachstum verantwortlich [52].  

 

Demnach soll ein direkter Zusammenhang zwischen dem Wachstum des 

Weichgewebes und dem Wachstum des Kondylus existieren [7, 52]. Jedoch 

konnte auch auf Grundlage dieser Theorie nicht exakt erklärt werden, wie es 

zur Wachstumsstimulation des Kondylus kommt. 

 

VOUDOURIS unterstützt die „growth relativity“ von ENDOW und HANS [10], die 

besagt, dass mandibuläres Wachstum durch eine Fusion aus funktionalen 

Faktoren, regionalen Kräften und extrakondylären Signalen gesteuert wird. 

Dadurch werden fingerartige Neuformationen von Knochen im Bereich der 

Fossa und des Kondylus initiiert, die in ihrer Richtung und in ihrem Ausmaß 

relativ zu der kieferorthopädischen Vorverlagerung des Kondylus stehen [52].  

 

Für die Knochenapposition sind zusammengefaßt hauptsächlich drei Stimuli 

verantwortlich: 

 

1. Die anteriore Verlagerung des Unterkiefers. 

2. Die Dehnung des viskoelastischen Gewebes. 

3. Die Transduktion der Kräfte über die Knorpelschicht in den Gelenkkopf. 

 

Die anteriore Verlagerung des Kondylus verursacht daher direkt die knorpelige 

Auskleidung der Fossa und regt sie zur lokalen Kalzifizierung an. Das am 

Diskus und am Kondylus inserierende retrodiskale Gewebe wird durch die 

Verlagerung des Unterkiefers gedehnt, wobei diese Dehnung einen 

gesteigerten Nährstoffeinstrom in den Knochen und damit Neustrukturierungen 

des Knochens bewirkt werden [52].  
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Mikroskopische Untersuchungen zeigten direkte Verbindungen zwischen dem 

viskoelastischen Gewebe, dem Knorpelüberzug des Kondylus und dem Diskus, 

deren Kommunikation damit ermöglicht ist [52].  
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1.2 Computertomographie 

 

Die Computertomographie generiert ein dreidimensionales Gebilde aus zwei-

dimensionalen Schichtbildern, die aus verschiedenen Richtungen aufge-

nommen wurden. Sie bedient sich dabei der herkömmlichen Röntgenstrahlung, 

die im Jahre 1895 von Wilhelm Conrad Röntgen entwickelt und erstmals an der 

Hand seiner Frau angewendet wurde.  

 

Die Entwicklung der Computertomographie ist auf die Physiker Allen M. 

Cormack und den Elektrotechniker Godfrey Hounsfield zurückzuführen, die 

diese Aufnahmetechnik im Jahre 1971 erstmals an einem Menschen erprobten. 

Im Jahre 1979 wurden sie dafür mit dem Nobelpreis der Medizin ausgezeichnet.  

 

 
Abbildung 1.4: Hounsfield neben einem Computertomog raphen der ersten Generation. 
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Abbildung 1.5: Moderner Computertomograph der Firma  designafairs. 

 

Das Verfahren der Computertomographie beruht auf der Messung von 

Strahlungsabsorptionen. Es wird eine Materie mit bekannter Intensität bestrahlt 

und am Ende des Strahlengangs registriert wie viel von der Ausgangsintensität 

noch vorhanden ist. Die Absorption steigt dabei proportional zur Dichte und 

Dicke der bestrahlten Materie. Aus der Differenz zwischen Eingangs- und 

Ausgangsintensität lässt sich ein Schwächungskoeffizient µ ermitteln, 

der.computergesteuert logarithmiert, digitalisiert und durch die dazugehörigen 

Grauwerte dargestellt wird. Je mehr Strahlenenergie von dem bestrahlten 

Körper absorbiert und folglich weniger Energie nach Durchdringung registriert 

wird, desto heller wird der Körper auf dem CT-Bild wiedergegeben. Körper 

dagegen, die eine besonders geringe Dichte haben, werden durch dunkle 

Graustufen repräsentiert. Angegeben werden diese Graustufen in Hounsfield-

Einheiten, die sich auf der Hounsfield-Skala wieder finden. Je nach CT-

Hersteller werden diese Einheiten auf die einzelnen Gewebe justiert. 
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Abbildung 1.6: Diagramm zur Darstellung einzelner G ewebe und ihrer zugehörigen 
Hounsfield-Unit. 
 

Am häufigsten ist die Skala so geeicht, dass reine Luft bei -1000 Hounsfield-

Einheiten, Wasser bei null und kompaktes Knochengewebe bei mehr als 1000 

Einheiten liegt. Nach unten ist die Skala bei -1024 begrenzt, nach oben hin ist 

sie offen. Die Hounsfield-Skala errechnet sich aus folgender Formel. Die CT-

Zahl beschreibt dabei den Wert der Hounsfield-Unit (HU) des untersuchten 

Gewebes. 

 

 

 

[5, 25, 26, 38] 
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1.3 Das Dach der Fossa mandibularis 

 

Bis vor zehn Jahren wurde dem Dach der Fossa mandibularis eher selten 

Aufmerksamkeit geschenkt. Begegnungen hatte man mit dieser Struktur 

lediglich bei Luxationen des Kondylus in die mittlere Schädelgrube oder bei 

Rekonstruktionen von Kiefergelenken. Seit einiger Zeit ist man sich jedoch 

bewusst geworden, dass es für den Erfolg von kieferorthopädischen Therapien 

und chirurgischen Eingriffen im Bereich des Kiefergelenks unerlässlich ist, die 

Reaktionen der Fossa auf funktionelle Reize hin zu untersuchen. So werden 

bisher enge Zusammenhänge zwischen Diskusperforationen, Diskusver-

lagerungen, Osteoarthritis und Gelenkergüssen mit den Umbauvorgängen im 

Bereich des Fossadaches diskutiert [21, 27, 50].  

 

BARRON beschäftigt sich in seinen Arbeiten über Dislokationen des Kondylus in 

die mittlere Schädelgrube und sucht nach Zusammenhängen mit dem 

Fossadach [1, 2]. Es ist bemerkenswert, dass Frauen doppelt so oft an dieser 

Form von Dislokation leiden, wie Männer.  

 

Lufteinschlüsse innerhalb des Fossadaches bilden einen weiteren Ansatzpunkt 

für Forschungen. Sie werden auf Computertomographiebildern gehäuft 

beobachtet, wobei ihre Ätiologie bisher noch ungeklärt ist. 
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1.3.1 Die Dicke des Fossadaches 
 

Bisher wurde nur in einer Arbeit die Dicke des Knochendaches in Abhängigkeit 

vom Alter und vom Geschlecht untersucht. Dazu wurden mit Hilfe eines 

digitalen Mikrometers die Fossadächer von 49 Verstorbenen an ihrer dünnsten 

Stelle vermessen. Das Patientengut verteilte sich nahezu gleichmäßig auf 

Männer und Frauen deren Alter zwischen 50 und 96 Jahren lag, wobei das 

Durchschnittsalter 73,8 Jahre betrug. Die aus der Studie gewonnenen 

Ergebnisse konnten keine Korrelation zwischen dem Geschlecht bzw. dem Alter 

mit der Fossadicke zeigen [20]. 

 

In weiteren Autopsiestudien konnte nachgewiesen werden, dass das Dach bei 

Gelenken mit Diskusperforationen und nach vollständiger Diskusentfernung [13] 

signifikant dicker ist, als das bei gesunden Gelenken [21]. Auch hierbei wurden 

die Messungen manuell mit einem Micrometer durchgeführt.  

 

Die aktuellste Studie zu diesem Thema wurde mit Hilfe der 

Computertomographie durchgeführt. Diese Studie besagt, dass die 

Dickenzunahme neben oben genannten Faktoren auch von einem 

Gelenkerguss beeinflusst werden kann. Bei Patienten mit Ergüssen im 

Kiefergelenk wurden signifikant dickere Fossadächer gefunden, als bei 

Patienten ohne Gelenkergüssen [27]. Des Weiteren stützt diese Studie 

vorausgegangene, die besagten, dass Diskusdeformationen im Gegensatz zu 

Diskusperforationen nicht mit der Roofthickness korrelieren. Entgegen seiner im 

Jahre 2001 veröffentlichten Autopsiestudie [21] konnte HONDA in dieser CT 

Studie [27] keine signifikanten Veränderungen der Knochendicke zwischen 

osteoarthitischen Gelenken und nicht osteoarthritischen Gelenken finden. 
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1.3.1.1 Methoden zur Vermessung des Fossadaches 

 

Das Knochendach der Fossa mandibularis wurde bisher mit unterschiedlichen 

Methoden vermessen. Jedoch wurde übereinstimmend die dünnste Stelle des 

Knochendaches für die Messungen präferiert. Dieser Bereich ist leicht zu 

reproduzieren und kann somit für den Vergleich zwischen Gelenken in 

unterschiedlichsten Studiengruppen verwendet werden.  

 

Kazuya Honda von der Nihon University School of Dentistry hat sich bisher 

wohl am intensivsten mit der Vermessung des Knochendaches auseinander-

gesetzt.  

 

HONDA benutzte im Jahre 2000 erstmals das „limited cone-beam X-ray CT 3DX 

multi-image mirco-CT“, um das Knochendach darzustellen und zu vermessen 

[19]. Mit Hilfe eines 360° Scans werden zweidimensi onale Abbilder erstellt und 

unter 8bits auf einem elektronischen Datenträger abgespeichert. Die Schicht mit 

der dünnsten Knochenstelle wurde von einem Observer ausgewählt und durch 

ein 3DX-image Programm vermessen. Die Strahlenbelastung konnte bei 

diesem Verfahren gegenüber den konventionellen Computertomographen 

verringert werden. Um dieses Verfahren zu evaluieren, verglich HONDA die 3DX-

Methode an 21 entnommen Kiefergelenken mit der Messung über ein per Hand 

verwendetes digitales Micrometer.  
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Abbildung 1.7: Das von H ONDA benutzte Mircometer zur Vermessung des Fossadaches  

[19]. 

 

Da keine signifikanten Unterschiede zwischen den beiden Methoden 

nachzuweisen waren, erwies sich das 3DX-Verfahren als praktikabel. Weiterhin 

sind Studien bekannt, die sich der herkömmlichen Computertomographie 

bedienten [27, 50]. Hinzu kommen weitere Autopsiestudien, die mit Hilfe von 

Schieblehren die dünnste Stelle im Knochen aufgesucht und vermessen haben 

[19, 20, 21]. 

 

1.3.2 Lufteinschlüsse im Fossadach 

 

Auf Computertomographiebildern stellen sich im Bereich des Daches der Fossa 

mandibularis häufig von Knochensubstanz abgeschlossene Lufträume dar. 

Einige Autoren vermuten, dass diese Hohlräume in einer Relation zum 

Kiefergelenk stehen [15]. Weshalb diese mit Luft gefüllten Hohlräume entstehen 

konnte bisher noch nicht eruiert werden. Manche vermuten, dass sie von 

Geburt an angelegt sind und durch Resorptionsvorgänge vergrößert werden 

[51]. 
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Abbildung 1.8: Transversaler Schnitt durch den Kopf  eines Patienten mit 

Lufteinschlüssen auf Höhe des Dachs der Fossa mandi bularis. 

 

Andere Überlegungen bringen eine Adaptationsreaktion der Fossa mit den 

Lufteinschlüssen in Verbindung. STAMM [48] beschreibt, dass sich die Dicke des 

Fossadaches an die Stellung des Kondylus adaptiert. Wird der Kondylus zum 

Beispiel durch eine kieferorthopädische Apparatur aus seiner Fossa gezogen, 

so soll das Dach der Fossa nachkommen und seine Dicke vergrößern. Dass 

Umbauvorgänge im Bereich der Fossa aufgrund von Kondylusverlagerungen 

stattfinden, wurde in Kapitel 1.3.1 bereits aufgezeigt. Im Rahmen dieser 

adaptiven Umbauvorgänge könnte es sein, dass bei überschießendem 

Wachstum keine homogene, solide Knochensubstanz, sondern vorerst aus 

Zeitersparnis nur ein Leitgerüst aus Knochen gebildet würde, in dem 

nichtknöcherne Areale eingebettet sind. 

 

Die so genannten „Aircells“ werden als Ausbreitungswege pathogener Prozesse 

und als Prädilektionsstellen sowie Indiz für Schädelbasisbrüche diskutiert [3, 11, 

15].  
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Differentialdiagnostisch sind diese Lufteinschlüsse nur schwer von 

Pseudozysten und Tumoren zu unterscheiden und bedürfen auch deswegen 

näherer Untersuchungen [15]. 

 

 
Abbildung 1.9: Sagittalschnitt durch ein Kiefergele nk mit Lufteinschlüssen im Dach der 

Fossa mandibularis. 
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1.4 Ziel der Studie 

 

Wie oben beschrieben, scheint das Kiefergelenk starken funktionellen 

Umbauvorgängen zu unterliegen. Ebenso konnte schon in vereinzelten Studien 

gezeigt werden, dass sich auch die Dicke des Knochendaches der Fossa 

mandibularis auf gewisse Reize hin verändert. Die themenspezifische Literatur 

wird von HONDA dominiert. Er verwendete und bewertete mehrere unter-

schiedliche Methoden zum Auffinden und Vermessen der knöchernen Struktur, 

suchte aber auch nach Faktoren, die das Knochendach beeinflussen können.  

 

Signifikant sicher ist, dass die Umbauvorgänge innerhalb des Kiefergelenkes 

bei der Therapie und der Diagnostik von Dysgnathien, sowie von Patienten mit 

craniomandibulären Dysfunktionen (CMD) und Traumata eine entscheidende 

Rolle spielen.  

 

Die Intention der vorliegenden Arbeit ist es, weitere funktionelle Faktoren 

aufzufinden, die die Dicke des Daches der Fossa mandibularis beeinflussen 

und vorhandene Ergebnisse mit eigenen zu vergleichen. Folgende Fragen 

werden fokussiert: 

 

1. Ist die Dicke des Fossadaches geschlechtsspezifisch? 

2.  Besteht ein Zusammenhang zwischen der Gelenkseite und der Dicke 

des Fossadaches? 

3.  Korreliert das Alter der Patienten mit der Dicke des Fossadaches? 

4.  Bestehen Abhängigkeiten zwischen Sklerosierungen bzw. 

Resorptionen des Kondylus und der Dicke des Fossadaches? 

5.  Stehen Pneumatisationen innerhalb des Fossadaches im 

Zusammenhang mit der Adaptationsfähigkeit der Fossa? 
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Parallel dazu sollte anhand des Softwareprogramms „ImageJ“ eine frei 

zugängliche und leicht zu reproduzierende Methode entwickelt werden, mit der 

man die dünnste Stelle des Fossadaches aufsuchen und vermessen kann.  
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2. Material und Methode 

 

2.1 Datenerhebung und Auswertung 

 

Die Daten für die Studie wurden dem „PACS“ (Picture Archiving and 

Communication System) der Radiologischen Abteilung des Universitätsklinikum 

Münster entnommen. Angefertigt wurden die CT-Aufnahmen mit Hilfe von 

Spiraltomographen der Hersteller Philipps und Siemens. Die Tomographen 

arbeiteten dabei mit einer Spannung von 120 kV und einer Stromstärke von 170 

mAs. Indem man in der PACS-Software den Filter auf „CT Angio“ bzw. „CT 

Head“ einstellt, kann man die für die Studie relevanten Aufnahmen direkt 

herausfiltern. Für die Datenauswahl war es wichtig, auf die Vollständigkeit des 

Schädels und auf eine ausgeglichene Altersstruktur zu achten.  

 

Alle verwendeten Daten entsprechen dem DICOM-Standard (Digital Imaging 

and Communication in Medicin), der es ermöglicht, die Daten 

herstellerunabhängig auszuwerten und die Bilder mit zusätzlichen 

Informationen etwa über Patient und Aufnahmetechnik zu versehen. Die 

Schichtdicke der CT-Aufnahmen der Studie lag zwischen 1,0 mm und 1,3 mm. 

Ausgewählte Daten wurden für jeden Patienten auf eine eigene CD-ROM 

gebrannt und archiviert.  

 

Die Software ImageJ 1.35s diente der Auswertung. ImageJ ist ein 

plattformunabhängiges Java-Programm, das gemeinfrei ist und kostenlos von 

der ImageJ-Homepage (http://rsb.info.nih.gov/ij/) herunter geladen werden kann. 

Ebenso kann über diese Seite auf ein zahlreiches Angebot an frei zugänglichen 

Plugins zugegriffen werden, die die Anwendungsmöglichkeiten dieses 

Programms erweitern. 

 



2. Material und Methode   

 24 

2.2 Patientengut 

 

Die Altersverteilung der Patientengelenke ergibt sich aus dem Balkendiagramm 

(Abb. 2.1). Das durchschnittliche Alter beträgt 47 Jahre. 
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Abbildung 2.1: Das Balkendiagramm stellt die Alters verteilung aller untersuchten 

Gelenke grafisch dar.  
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2.2.1 Patienteneinteilung 
 

Die Patienten wurden nach CT-Bild Befund und nach Akteneinträgen der 

Poliklinik für Kieferorthopädie des Universitätsklinikum Münster in vier 

unterschiedliche Gruppen eingeteilt: 

 

1. jaws open (control group) 

2. jaws closed (control group) 

3. resorptions 

4. sclerosis 
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2.2.1.1 Kontrollgruppe 

 

Beide Kontrollgruppen zeigen keine pathologischen Veränderungen im 

Kiefergelenk. Da sich jedoch das Gelenkspaltvolumen, das in einer Parallel-

arbeit beschrieben wird, durch die Verlagerung des Kondylus beim Öffnen des 

Kiefers vergrößert, musste die Kontrollgruppe gesplittet werden. Weil die Kiefer-

stellung in Bezug auf Werte der vorliegenden Arbeit keinen Einfluss nimmt, wird 

die Kontrollgruppe im Folgenden zusammengelegt.  

 

 
Abbildung 2.2: Gelenk der Kontrollgruppe ohne patho logische Veränderungen.  
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2.2.1.2 Resorptionen 

 

Resorptionen werden in dieser Studie als Gelenke definiert, deren Kondylus-

Fossa Relation aus pathologischen Gründen abnimmt. Daher gelten nicht nur 

Gelenke zu den Resorptionen, bei denen der Kondylus an Substanz verliert, 

sondern auch Gelenke, in denen der Kondylus aus pathologischen Gründen 

teilweise aus der Fossa getreten ist. Auch in diesem Falle verändert sich die 

Relation zwischen Kondylus und Fossa zu Gunsten der Gelenkgrube.  

 

 
Abbildung 2.3: Sagittalschnitt eines Resorptionsgel enks. Die Lamina Dura ist teilweise 

unterbrochen und der Kondylenkopf erscheint aufgelö st. 
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2.2.1.3 Sklerosierungen 

 

Sklerosierungen sind unserer Definition nach Gelenke, deren Kondylus-Fossa 

Relation auf Grund von pathologischen Veränderungen zunehmen. Im 

Gegensatz zu den Resorptionen kann dies nur durch ein Wachstum des 

Kondylus entstehen. 

 

 
Abbildung 2.4: Sagittalschnitt eines sklerosierten Gelenks. Der Gelenkspalt ist deutlich 

verkleinert. Der Kondylus stellt sich blasig dar. 
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2.3 Ermittlung der dünnsten Knochenstärke des Fossa daches 

 

Im Rahmen dieser Studie wurde auf einen Datensatz zurückgegriffen, der durch 

ein Verfahren modifiziert wurde, das eine möglichst hohe Reproduzierbarkeit 

gewährleistet. Dieses Verfahren ist Teil einer Studie, die sich mit der 

Reproduzierbarkeit von so genannten landmarks befasst.  

 

Unter einem landmark versteht man einen anatomischen Punkt, der exakt 

beschrieben werden kann und sich in Strukturen mit einer hohen Präzision 

darstellen und markieren lässt. So kommen vor Allem knöcherne Strukturen in 

Frage. Lassen sich diese landmarks in unterschiedlichen Individuen in einer 

Kontinuität feststellen, so werden sie als homologe landmarks bezeichnet. 

 

Für die Studie wurden drei landmarks ausgewählt, über die eine im 

dreidimensionalen Raum eindeutig reproduzierbare Ebene festgelegt werden 

konnte. Der CT-Datensatz wurde anschließend mit Hilfe des ImageJ PlugIn 

TMJ_Rotation im dreidimensionalen Raum rotiert, sodass alle drei festgelegten 

landmarks innerhalb einer Schichtebene lagen. Dieser rotierte Datensatz wird 

als Ursprungsdatei der „Z-Project“ Methode verwendet. Für eine detaillierte 

Beschreibung dieses Verfahrens wird auf die Dissertation von FLEUTER [22] 

verwiesen. 

 

Im folgenden Abschnitt werden zwei Methoden präsentiert, wie man das Dach 

der Fossa mandibularis an seiner dünnsten Stelle aufsuchen und vermessen 

kann.  

 

Die einzelnen Gelenke wurden zunächst mit der „Z-Project“ Methode untersucht. 

Da sich Ungenauigkeiten in der „Z-Project“ Methode bei Lufteinschlüssen 

ergeben hatten, wurden alle Ergebnisse von Gelenken mit Lufteinschlüssen 

durch eine „manuelle Methode“ überprüft und gegebenenfalls korrigiert.  
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2.3.1 Durchführungsprotokoll 

 

2.3.1.1 Z-Project-Methode 

 

Die Z-Project-Methode wird in elf Arbeitsschritten durchgeführt, die nachfolgend 

detailliert beschrieben werden: 

 

Arbeitsschritt 1 

 

Nach dem Starten des Bildbearbeitungsprogramm ImageJ wird der, nach dem 

von FLEUTER [22] beschriebenen Verfahren, vollständig rotierte Stack geöffnet. 

 

(File → Open → „name_vorname_kglpr1r2r3“). 

 

 
Abbildung 2.5: Ausgangsstack. 

 
Arbeitsschritt 2 

 

Für die Messung der roofthickness wird ein weiterer Ordner „torfm“, der für 

thickness of the roof of the fossa mandibularis steht, in den jeweiligen 



2. Material und Methode   

 31 

Patientenverzeichnissen angelegt und der Datensatz zunächst unverändert in 

diesem Ordner abgespeichert.  

 

(File → save as → Zip → den Ordner „torfm“ erstellen und die Datei in 

dem neuen Ordner als „name_vorname_kglpr1r2r3“ abspeichern.) 

 

Arbeitsschritt 3   

 

Im dritten Arbeitsschritt wird eine Grundebene aufgesucht. Es handelt sich 

hierbei um die Schicht des Stacks, die als erste oberhalb des Kondylus liegt. 

Darunter gelegene Schichten werden aus dem Stack entfernt. Der Benutzer 

nutzt dabei das PlugIn „Silce Remover“, das ihn auffordert, das gewollte 

Schichtenintervall anzugeben. Als erste Schicht wird die zuvor lokalisierte 

Grundebene angegeben. Für die obere Intervallgrenze ist es von Nöten, dass 

das knöcherne Dach der Fossa mandibularis noch innerhalb des Intervalls liegt.  

 

(Plugin → Slice Remover → dann die Schichten eingeben, die 

herausgeschnitten werden sollen. Anschließend wird dem Dateinamen 

ein „w“ für wegschneiden hinzugefügt und abgespeichert. → File → 

Save As → Zip → „name_vorname_kglpr1r2r3w“). 
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Abbildung 2.6: Verkürzter Stack mit allen Schichten , die oberhalb des Kondylus liegen. 
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Arbeitsschritt 4 

 

Die Schichten unterhalb der Grundebene müssen, wie unten beschrieben, für 

den folgenden Arbeitsschritt entfernt werden. Das tool „Z-Project“ projiziert alle 

übereinander liegenden Grauwerte der einzelnen Schichten des Stacks in eine 

gemeinsame Schicht. Pixel, denen in der Projektion helle Grauwerte 

zugeordnet werden, stehen für eine strahlendichte Materie des vom Pixel in 

kaudocranialer Richtung eingenommen Bereiches. Analog wird 

strahlendurchlässige Materie durch dunklere Graustufen repräsentiert.  

 

(Image → Stacks → Z – Project → alle Schichten auswählen und 

Projection Type  auf Max Intensity  stellen. → File → Save As → Zip→ 

„zprojection of name_vorname_kglpr1r2r3w“). 

 

 
Abbildung 2.7: Summation aller Graustufen der einze lnen Schichten zu einem Bild nach 

Anwendung des „Z-Project“ Tools.  
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Arbeitsschritt 5  

 

Im folgenden Schritt muss der Bereich mit dem dunkelsten Grauwert im Z-

Project-Bild aufgefunden werden. Dieser Bereich steht, wie unter Arbeitsschritt 

4 erklärt, für die geringste Strahlendichte und somit für die dünnste 

Knochenstärke im Bereich des Fossadaches. Würde man den strahlendichten 

Kondylus im Stack belassen, wäre die Projektion verfälscht. Die Lokalisation 

des Pixels mit dem dunkelsten Grauwert erfolgt mit dem tool „Threshold“. Mit 

dessen Hilfe lässt sich ein Schwellenwert für Graustufen definieren. Unterhalb 

dieser Schwelle liegende Graustufen werden farblich hervorgerufen. 

Bildbereiche mit Grauwerten oberhalb dieser Schwelle bleiben unverändert.   

 

Mit dem Tool „Polygon selections“ wird die Gelenkkammer durch ein Polygon 

manuell umrandet (siehe Abb. 2.8), um das für die Messung der roofthickness 

relevante Gebiet vorher einzugrenzen. Da die Gelenkkammer in dem Z-Project-

Fenster nicht zu lokalisieren ist, wird stellvertretend die Datei 

„name_vorname_kglpr1r2r3w“ aufgerufen, die kaudalste Schicht des Stacks 

(Grundebene) ausgewählt und nachher auf das Z-Project-Fenster transferiert. 

 

 
Abbildung 2.8: Mit dem Tool „Polygon selections“ um randete Gelenkkammer. 
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Lufteinschlüsse dürfen in keiner der Schichten innerhalb der Markierung liegen 

und müssen wie in Abb. 2.9 dargestellt ausgeschlossen werden, indem 

einzelne Eckpunkte des Vielecks versetzt werden. Auch sie würden, äquivalent 

zu dem Beispiel des Kondylus, zu einer Verfälschung des Ergebnisses führen. 

Im Unterschied zum Kondylus würde jedoch ein Belassen der Lufteinschlüsse 

nicht zu einem zu hellen, sondern aufgrund der niedrigen Strahlenabsorption zu 

einem zu dunklen Grauwert führen. Die Markierung durch das Tool „Polygon 

selections“ kann wie folgt auf das Z-Project-Fenster transferiert werden.  

 

(Edit → Selection → Restore Selection) 

 

 
Abbildung 2.9: Lufteinschlüsse, die zu einer Verfäl schung der Z-Project-Methode führen, 
werden von der Markierung des Gelenksspaltes ausgen ommen . 
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Arbeitsschritt 6   

 

Innerhalb des markierten Gelenkspaltes sucht man nun mit dem „Treshold“ die 

Stelle mit den geringsten Grauwerten auf.  

 

(Image → Adjust → Threshold)  

 

Es müssen zunächst beide Steuerleisten des Thresholds nach links auf ihren 

Ursprung geschoben werden. Durch die Variation der Steuerleisten lässt sich 

ein Intervall von Grauwerten anfärben. Der minimale Grauwert wird durch die 

obere Steuerleiste definiert. Durch die untere lässt sich der maximale Grauwert 

festlegen. Es ist hierbei irrelevant, welchen Grauwert der Ursprung annimmt. Er 

unterliegt zwischen den einzelnen Z-Project-Bildern einer Variabilität. Nachdem 

der minimale und der maximale Wert auf den Ursprung gelegt wurden, erhöht 

man den maximalen Grauwert sukzessiv über die untere Steuerleiste bis im 

Bereich der markierten Gelenkkammer ein gefärbter Pixelbereich erscheint. 

Diese Stelle soll im nächsten Schritt durch Koordinaten eindeutig festgelegt 

werden. Dazu wird mit Hilfe des tools „point selection“ der angefärbte Bereich 

punktuell markiert und durch folgenden Befehl vermessen: 

 

(Analyze → Measure) 

 

Ein Fenster „Results“ aus dem man den x- und y-Wert der gesuchten 

Koordinate entnimmt wird automatisch geöffnet. 
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Abbildung 2.10: Diesem „results-Fenster“ werden die  Koordinaten des punktuell 
markierten Bereiches entnommen. 
 
 

 
Abbildung 2.11: Oben sieht man die zwei Steuerleist en des „Thresholds“. Dabei muss die 

obere Steuerleiste immer ganz links stehen und die untere soweit von links nach rechts 

geschoben werden, bis in dem Bild rechts unten ein roter Pixel innerhalb der Markierung 

auftaucht. Das Bild unten links zeigt, wie Lufteins chlüsse von der Markierung 

ausgeschlossen werden. 
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Arbeitsschritt 7  

 

Um einen Sagittalschnitt zu erhalten, auf dem das Dach der Fossa mandibularis 

seine geringste Dicke aufweist, müssen noch weitere Schritte vollzogen werden.  

 

Man öffnet wieder die Ausgangsdatei „name_vorname_kglpr1r2r3“ und zieht mit 

dem Tool „straight line selections“ eine vertikale Linie von Bildgrenze zu 

Bildgrenze. Dabei ist es wichtig, dass die Linie exakt, wie in Abbildung 2.12 

dargestellt, an den Bildrändern abschließt und nicht vorher endet. Wird die 

Markierungslinie zu kurz gewählt, so würden die zuvor ermittelten Koordinaten 

ihre Gültigkeit verlieren. Die Markierungslinie wird ausschließlich horizontal 

verschoben, bis sie auf dem unter Arbeitsschritt 6 eruierten x-Wert liegt. Der x-

Wert, auf dem sich die Markierungslinie gegenwärtig befindet, kann aus dem 

ImageJ Hauptfenster entnommen werden (Abb. 2.13). 

 

 
Abbildung 2.12: Ausgangsstack mit vertikaler Markie rung für die Herstellung eines 

Reslice.  
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Abbildung 2.13: Aus dem ImageJ Hauptfenster kann de r x-Wert, auf dem sich die 
Makierungslinie aus Abb. 2.12 befindet, abgelesen w erden.  

 

Arbeitsschritt 8  

 

Um den sagittalen Schnitt des linear, markierten Bereiches zu generieren, 

verwendet man das tool „Reslice“.  

 

(Image → Stacks → Reslice)   

 

Der „Reslice“ rekonstruiert orthogonale Schichten eines zuvor im CT-Bild 

ausgewählten Bereiches. Benutzt man wie in unserem Falle zur Auswahl das 

tool „straight line selections“, so erhält man demnach eine Abbildung, die 

orthogonal zu der Markierung steht und in ihrer Ausdehnung der Markierung 

entspricht. Verwendet man zur Markierung das tool „rectangular selections“, so 

würde man nach durchgeführtem Reslice nicht nur eine orthogonale Schicht 

erhalten, sondern einen Stack aus mehreren orthogonalen Schnitten. 

 

Der rotierte Datensatz wird  unter dem Dateinamen „reslice of 

name_vorname_kglpr1r2r3“ abgespeichert. 

 

(File → Save As → Zip→ „reslice of name_vorname_kglpr1r2r3“). 
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Arbeitsschritt 9  

 

Man öffnet die Datei „reslice of name_vorname_kglpr1r2r3“, um in der erstellten 

sagittalen Abbildung die dünnste Knochenstärke mit Hilfe der unter Arbeitschritt 

6 ermittelten Koordinaten ausfindig zu machen. 

 

Da sich die Abbildung in einer anderen Raumebene befindet, sucht man nun 

auf der x-Achse den Wert der y-Koordinate auf. Man zieht dazu erneut mit dem 

tool „straight line selection“ eine Linie, deren Ausdehnung in diesem Fall frei 

gewählt werden darf. Die Linie variiert man nun so lange auf der x–Achse bis 

der y–Wert aus Arbeitsschritt 6 erreicht wird. Die Position kann dabei wieder, 

wie in Abbildung 2.13 dargestellt, dem ImageJ – Fenster entnommen werden. 

 

Methodisch bedingt, kann die Linie nur näherungsweise den gesuchten Bereich 

angeben. Ausschlaggebend ist, was durch den später verwendeten „Tres-

hold“ dargestellt wird.  

 

 
Abbildung 2.14: Sagittaler Reslice des in Abb. 2.12  markierten Bereiches. Die gelbe Line 

dient zum Auffinden der gesuchten y-Koordinate. 
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Arbeitsschritt 10  

 

Nach unserer Definition sind alle Strukturen mit einem Grauwert über 1224 HU 

knöchern. So wird durch das Festlegen eines Grauwerteintervalls von 0 – 1224 

HU nach Definition jede nicht knöcherne Struktur durch den Treshold angefärbt.  

 

(Image → Adjust → Threshold → set → In die obere Spalte trägt man 

den Wert 0 und in die untere den Wert 1224 ein).  

 

Die kürzest mögliche Verbindung zwischen den angefärbten, nicht knöchernen 

Geweben stellt die gesuchte Stelle des Knochendaches dar. Es muss also nun 

manuell nach der kürzesten Strecke zwischen den angefärbten Gewebe-

grenzen gesucht werden. Die Strecke muss dabei nicht unbedingt orthogonal, 

wie in Abb. 2.15, sondern kann auch diagonal verlaufen.  

 

 
Abbildung 2.15: Links erkennt man die Verbindung de r kürzesten Strecke; Rechts  ist der 

Threshold mit der für Knochen eingestellten Grenzsc hwelle abgebildet. 
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Arbeitsschritt 11  

 

Hat man den geringsten Abstand optisch lokalisiert, verbindet man die 

Grenzbereiche mit dem Tool „straight line selection“ und lässt die 

Streckenlänge bestimmen. Der Wert kann aus dem Fenster 

„Results“ entnommen werden. 

 

(Analyze → Measure) 

 

 
Abbildung 2.16: Fenster, aus dem man die gesuchte S treckenlänge unter 

„Length“ ablesen kann. 

 

 

Nach abgeschlossener Arbeit muss der Ordner „torfm“ folgende acht Dateien 

enthalten: 

 

Mustermann_m_kglpr1r2r3 

Mustermann_m_kgrpr1r2r3 

Mustermann_m_kglpr1r2r3w 

Mustermann_m_kgrpr1r2r3w 

Zprojection of Mustermann_m_kglpr1r2r3w 

Zprojection of Mustermann_m_kgrpr1r2r3w 

Reslice of Mustermann_m_kglpr1r2r3 

Reslice of Mustermann_m_kgrpr1r2r3 
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2.3.1.2 Regeln zur Z-Project-Methode 

 

Bei einer Anzahl der Patienten-Stacks kann die Z-Project-Methode nicht ohne 

weiteres angewendet werden. Wie aus Abb. 2.17 ersichtlich, werden durch den 

Treshold, mit dem von uns definierten Grauwerteintervall (0-1224 HU) nicht alle 

nichtknöchernen Gewebe angefärbt. Anteile der Gelenkkammer blieben 

unmarkiert, obwohl sie wissentlich keine knöchernen Strukturen sind. Um 

solche Ausnahmen trotzdem mit in die Studie einzubeziehen, wurden Regeln 

konzipiert. Bei konstanter Anwendung dieser Regeln bleibt jede Auswertung 

reproduzierbar und somit auch vergleichbar.  

 

1. Ist der Kondylus wie in Abb. 2.17 nicht vollständig von der Threshold-

Markierung umrandet und liegt die orthogonale Linie auf der x-Achse mit 

dem ehemaligen Wert der y-Koordinate innerhalb der Markierung, wird 

weiterhin die kürzeste Strecke gemessen. 

 

 
Abbildung 2.17: Links: Die Markierung des „Threshol ds“ verläuft nicht kontinuierlich um 
den Kondylus. Die orthogonale Line liegt im Bereich  der gegenüberliegenden 
Thresholdmarkierungen.  
Rechts: Markierung der kürzesten Strecke durch „str aigth line selections“. 
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2. Liegt die lineare Markierung des „straight line selection“ jedoch wie in 

Abb. 2.18 außerhalb von gegenüberliegenden Markierungsgrenzen des 

„Thresholds“, weicht man von dem üblichen Protokoll ab und fährt wie 

folgt fort: Die lineare Markierung muss wiederum auf dem korrekten y-

Koordinatenwert positioniert werden. Das obere Ende der Strecke wird 

anschließend ausnahmslos in vertikaler Richtung verschoben, bis es am 

Grenzpunkt der Threshold-Markierungsgrenze liegt. Das Grauwerte-

intervall des „Threshold“ wird nun sukzessiv erweitert, indem der  

maximale Grauwert erhöht wird. Dazu wird die untere Steuerleiste des 

„Tresholds“ schrittweise weiter nach rechts geführt bis sowohl die obere 

als auch die untere Markierungsgrenze des „Thresholds“ die x-

Koordinate erreicht hat, auf dem sich die Markierungslinie befindet (siehe 

Abb. 2.19). Im Anschluss wird erneut die kürzest mögliche Strecke durch 

Variation des unteren Streckenursprungs aufgesucht und vermessen. 

Die Position des oberen Ursprungs der Strecke darf nicht mehr 

verschoben werden. 

 

 
Abbildung 2.18: Es ist deutlich zu erkennen, dass d ie Markierung, die den Gelenkspalt 

symbolisiert, noch nicht die gelbe Line erreicht ha t. 
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Abbildung 2.19: Die untere Steuerleiste des Thresho lds wurde über den Normalwert 1224 

hinaus erhöht bis die Markierung des Gelenkspaltes die x-Koordinate der 

Markierungslinie erreicht hat. Die kürzeste Strecke  wurde durch Variation des unteren 

Streckenendes markiert, wobei die Position des ober en Streckenendes erhalten bleibt. 

 

2.3.2 Manuelle Methode 

 

Um die Ergebnisse der zuvor beschriebenen Methode zu überprüfen, kann man 

auch die dünnste Knochenstärke des Dachs der Fossa mandibularis manuell 

bestimmen. Die manuelle Bestimmung erfolgt in zwei Arbeitsschritten, die 

nachfolgend beschrieben werden. 

 

Arbeitsschritt 1  

 

Man greift identisch zur Z-Project-Methode auf die Ausgangsdatei im Ordner 

„gelenke“ zurück. 

 

(File → Open → „name_vorname_kglpr1r2r3“) 

Das gesamte Bild muss mit Hilfe des Tools „rectangular selections“ markiert 

und ein Reslice des markierten Bereiches angefertigt werden. (Image → 

Stacks → Reslice)  
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Abbildung 2.20: Das Bild ist hier mit dem Tool „rec tangular selections“ großzügig 

markiert. 

 



2. Material und Methode   

 47 

Man erhält einen sagittalen Stack, der dieses Mal aus mehreren Schichten 

besteht. Es ist sinnvoll, diesen Stack einmal komplett durchzuscrollen. So kann 

eine optische Eingrenzung vorgenommen werden, in welchen Schichten die 

dünnste Knochenstärke des Fossadaches liegt.  

 

 
Abbildung 2.21: Sagittale Darstellung des Gelenks z ur optischen Eingrenzung. 

 

Arbeitsschritt 2  

 

Aus Übersichtsgründen sollte erst dann der „Threshold“ aktiviert werden, um 

endgültig die Schicht zu finden, in der die roten Markierungsgrenzen den 

geringsten Abstand voneinander haben. Das weitere Verfahren ist mit den 

Punkten 9-11 der Z-Project-Methode identisch. 

 

 
Abbildung 2.22: Der rot eingefärbte Bereich stellt alle nichtknöchernen Anteile des 

Gelenks dar. 
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2.4 Evaluierung von Lufteinschlüssen im Fossadach 

 

Zur Verifizierung von Lüfteinschlüssen innerhalb des Fossadaches wurde der 

Stack manuell durchgescrollt. Das Ausmaß der Pneumatisationen wurde 

subjektiv von einem Observer in vier aufsteigende Kategorien „none“, „poor“, 

„moderate“ und „considerable“ eingeteilt. 

 

          
Abbildung 2.23: Transversaler (links) und sagittale r (rechts) Schnitt eines Gelenkes ohne 

Lufteinschlüsse. 
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Abbildung 2.24: Transversaler (links) und sagittale r (rechts) Schnitt eines Gelenkes mit 

wenigen Lufteinschlüssen.  

 

 

          
Abbildung 2.25: Transversaler (links) und sagittale r (rechts) Schnitt eines Gelenkes mit 

mäßigen Lufteinschlüssen.  
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Abbildung 2.26: Transversaler (links) und sagittale r (rechts) Schnitt eines Gelenkes mit 

umfangreichen Lufteinschlüssen. 
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2.5 Reproduktion der Z-Project-Methode 

 

Die intra- und interindividuelle Reproduzierbarkeit der Z-Project Methode wurde 

anhand von 20 Gelenken durchgeführt. Diese wurden aus dem Patientengut 

durch einen Zufallsgenerator ausgewählt. Die intraindividuelle 

Reproduziertbarkeit ergibt sich aus einer ersten Messung und einer zeitlich, 

versetzten, zweiten Messung des gleichen Observers. Zum Erhalt der 

interindividuellen Reproduzierbarkeit werden die von zwei unabhängigen 

Observern ermittelten Messungen verglichen. 

 

2.6 Statistik  

Die statistische Auswertung der Daten erfolgte in Zusammenarbeit mit dem 

Institut für medizinische Informatik und Biomathematik der Westfälischen 

Wilhelms-Universität Münster anhand des Statistikprogramms SPSS für 

Microsoft Windows 14.0.1 (SPSS Inc. Chicago, Illinois, USA). Zur Auswertung 

wurden verschiedene Verfahren benutzt, die im Folgenden kurz vorgestellt 

werden. 

 

Signifkanz 

 

Die Signifikanz beschreibt die Wahrscheinlichkeit, dass Unterschiede oder 

Zusammenhänge durch Zufall entstanden sind. Je geringer die Signifikanz ist, 

desto wahrscheinlicher ist es, dass die Unterschiede oder Zusammenhänge 

nicht durch Zufall entstanden sind. Durch so genannte Signifikanztests lässt 

sich das Signifikanzniveau p ermitteln und die Irrtumswahrscheinlichkeit 

abschätzen. Es werden vier verschiedene Signifikanzniveaus angegeben: 

 

nicht signifikant = p > 0,05 

signifikant = p < 0,05 

hoch signifikant = p < 0,01 

höchst signifikant = p < 0,001 
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Mann-Whitney-U-Test 

 

Der Mann-Whitney-U-Test ist ein nichtparametrischer Test für unverbundene 

Stichproben. Dieser Test wird auch als Homogenitätstest bezeichnet. Er gibt an, 

wie hoch die Signifikanz der Übereinstimmung zweier unabhängiger Variablen 

zu einer gemeinsamen Grundgesamtheit ist. 

 

In dieser Arbeit wurde der Mann-Whitney-U-Test dazu verwendet, die 

Abhängigkeiten der roofthickness innerhalb der Kontrollgruppe von folgenden 

Variablen zu testen: 

 

 1. Geschlecht (Kapitel 3.2.1) 

  2. Gelenkseite (Kapitel 3.2.3) 

 3. Befundgruppen (Kapitel 3.3) 

 

Korrelationskoeffizient 

 

Der Korrelationskoeffizient nach Bravais und Pearson gibt den Grad des 

linearen Zusammenhangs zweier Variablen an. Er kann Werte zwischen +1 und 

-1 annehmen. Beträgt er +1, dann besteht ein vollständig positiver linearer 

Zusammenhang. Bei -1 ein vollständig negativer. Je näher der Wert an 0 liegt, 

desto geringer ist der lineare Zusammenhang zwischen den Variablen. Zur 

Errechnung des Korrelationskoeffizienten wurde der Kendall-Tau-b-Test 

angewendet. Anhand dessen wurde die Reliabilität der Z-Project-Methode 

überprüft. Dazu wird der Korrelationskoeffizient zwischen den Messungen der 

roofthickness eines Interobservers und eines Intraobservers ermittelt. Je höher 

dabei der Korrelationkoeffizient ist, desto größer ist die Reliabilität der 

untersuchten Methode. 
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Box-Whisker-Plot 

 

Ein Boxplot ist eine grafische Darstellung, die fünf Werte auf einen Blick 

darstellt (z.B. Abb. 3.1). Dazu gehören der Median, zwei Quartile und die zwei 

Extremwerte. Die Quartile zusammen werden auch als Box bezeichnet. Die Box 

enthält 50 % der Daten und soll die Streuung verdeutlichen. In ihr ist der 

Median eingezeichnet. Die äußeren Quartilgrenzen halbieren jeweils wieder die 

obere und untere Hälfte der Stichprobe.  

 

Die dünneren äußersten Striche geben den oberen und unteren Extremwert an, 

die noch nicht als Ausreißerwerte bewertet werden. Die Strecken zwischen den 

Extremwerten und den Quartilgrenzen werden „Whisker“ genannt. 

 

Median 

 

In einer geordneten Stichprobe mit einer ungeraden Zahl von Werten ist der 

Median der Wert, der genau in der Mitte der Anzahl aller Werte liegt. Bei einer 

geraden Anzahl, gibt es demnach zwei Mediane. Der Vorteil des Median 

gegenüber dem Mittelwert ist, dass er stabiler gegenüber Ausreißerwerten ist. 

 

Arithmetische Mittel (Mittelwert) 

 

Der Mittelwert ist die Summe aller Messwerte, dividiert durch ihre Anzahl. 

Extreme Ausreißerwerte beeinflussen ihn stark.  

[4, 23]
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3. Ergebnisse 

 

3.1 Häufigkeiten des Patientenguts 
 

Die Häufigkeiten sind gemäß Tabelle 1 verteilt. Die Kontrollgruppe repräsentiert 

mit 382 Gelenken die größte Gruppe, die sich zu 52,9% in männliche und zu 

47,1% in weibliche Gelenke aufteilt. Es gab 49 Resorptionen, die zu 26,5% 

männliche und zu 73,5% weibliche Gelenke betrafen. Sklerosierungen des 

Kondylus wurden bei insgesamt 20 Gelenken befundet, davon 16 weibliche, 

demnach viermal mehr als männliche Gelenke.  

 

Tabelle 1 

Häufigkeiten der Gelenke

101 90 191

26,4% 23,6% 50,0%

101 90 191

26,4% 23,6% 50,0%

202 180 382

52,9% 47,1% 100,0%

6 18 24

12,2% 36,7% 49,0%

7 18 25

14,3% 36,7% 51,0%

13 36 49

26,5% 73,5% 100,0%

2 9 11

10,0% 45,0% 55,0%

2 7 9

10,0% 35,0% 45,0%

4 16 20

20,0% 80,0% 100,0%

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

Anzahl

% der Gesamtzahl

right

left

side

Gesamt

right

left

side

Gesamt

right

left

side

Gesamt

contr1
control group

resorption

sclerosis

m f

sex

Gesamt
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3.2 Roofthickness in der Kontrollgruppe 

3.2.1 Geschlecht  

 

Die Tabelle 2 zeigt, dass 197 männliche und 168 weibliche Gelenke in die 

Auswertungen einbezogen werden konnten. Bei Männern beträgt die mittlere 

roofthickness 3,2 ± 1,5 mm, bei Frauen 3,1 ± 1,4 mm. Es besteht kein 

signifikanter Unterschied in der roofthickness zwischen Männern und Frauen 

(p>0,05). 
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Abbildung 3.1: Gegenüberstellung der roofthickness in Abhängigkeit vom Geschlecht 

mittels eines Boxplots. Es kann kein signifikanter Unterschied herausgestellt werden. 
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Tabelle 2 

Deskriptive Statistik der Roofthickness

R_thick

197 3,2 1,5 3,0 ,4 8,5

168 3,1 1,4 2,8 ,0 8,1

365 3,2 1,5 2,9 ,0 8,5

sex
m

f

Insgesamt

N Mittelwert
Standarda
bweichung Median Minimum Maximum

 

 

3.2.2 Alter 

 
Die nachfolgenden Diagramme (Abb. 3.2 und 3.3) zeigen die lineare 

Kurvenanpassung zwischen dem Alter und der roofthickness. Man erkennt 

sowohl bei Männern, als auch bei Frauen einen marginalen Anstieg. Die 

Steigung der Geraden beträgt bei Männern 0,006 und bei Frauen 0,13. Der 

Korrelationskoeffizient nach Pearson beträgt bei Männern 5% und bei Frauen 

24%. 

80,0060,0040,0020,00

age

10,00

8,00

6,00

4,00

2,00

0,00

sex: m

Roofthickness

  
Abbildung 3.2: Lineare Darstellung der Abhängigkeit  zwischen der roofthickness von 

dem Alter bei Männern. Die schwache Steigung lässt auf keine signifikante Korrelation 

zwischen den beiden Variablen schließen.  
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80,0060,0040,0020,00

age

10,00
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4,00

2,00

0,00
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Roofthickness

 
Abbildung 3.3: Lineare Darstellung der Abhängigkeit  zwischen der roofthickness und 

dem Alter bei Frauen. Auch hier weist der schwache Steigungsgrad auf keine signifikate 

Korrelation zwischen den beiden Variablen hin.  
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3.2.3 Gelenkseite 

 
Bei 191 rechten Gelenken konnte eine mittlere roofthickness von 3,0 mm 

festgestellt werden. Das Minimum beträgt 0,4 mm und das Maximum 7,1 mm. 

Das arithmetische Mittel der linken 191 Gelenke liegt bei 3,4 mm. Das 

Werteintervall erstreckt sich über eine roofthickness von 0 mm bis zu 8,5 mm. 

Der „Man-Whitney-U-Test“ ergab, dass es einen signifikanten Unterschied 

(p=0,01) zwischen den Gelenkseiten gibt. 
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Abbildung 3.4: Gegenüberstellung der roofthickness in Abhängigkeit von der 

Gelenkseite mittels eines Boxplots. Es konnte ein h och signifikanter Unterschied (p=0,01) 

herausgestellt werden. 
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3.3 Roofthickness der Befundgruppen 

 

Bei Gegenüberstellung der Gruppen Sklerosierungen- und Resorptionen mit der 

Kontrollgruppe ergaben sich zur roofthickness folgende Mittelwerte. Die 

Kontrollgruppe besitzt mit 3,2 mm den größten Mittelwert; gefolgt von der 

Gruppe der Sklerosierungen mit 2,9 mm. Das kleinste arithmetische Mittel 

besitzen die Resorptionen mit 2,7 mm. Über den „Man-Whitney-U-Test“ konnte 

lediglich ein signifikanter Unterschied (p=0,004) zwischen der Kontrollgruppe 

und den Resorptionen festgestellt werden. 
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Abbildung 3.5: Gegenüberstellung der roofthickness in Abhängigkeit von der 

Gruppeneinteilung mittels eines Boxplots. Es konnte  ein signifikanter Unterschied 

(p=0,004) zwischen der Gruppe „control group“ und d er Gruppe 

„resorption“ herausgestellt werden. Alle anderen Ko mbinationen wiesen keine 

signifikanten Unterschiede auf. 

 



3. Ergebnisse  
 

 60 

3.4 Quantitäten der Lufteinschlüsse im Dach der Fos sa 

 

Lufteinschlüsse im Dach der Fossa mandibularis konnten bei 47,5 % von 451 

Gelenken beobachtet werden. Davon wurden 16,2% mit „poor“ (wenige 

Pneumatisationen), 18,6% mit „moderate“ (mäßige Pneumatisationen) und 

12,6% mit „considerable“ (umfangreiche Pneumatisationen) bewertet.  

 

In der Kontrollgruppe waren in 52,1% der 328 Fälle keine Pneumatisationen zu 

erkennen. Die restlichen Gelenke teilten sich zu 16% in „poor“, zu 18,3% in 

„moderate“ und zu 13,6% in „considerable“ auf. Die Gelenke mit Resorptionen 

enthalten zu 53,1% keine, zu 16,3% wenige, zu 20,4% mäßige und zu 10,2% 

umfangreiche Lufteinschlüsse im Fossadach. Gelenke mit Sklerosierungen 

enthalten zu 60% keine, zu 20% wenige, zu 20% mäßige Lufteinschlüsse. Mit 

„considerable“ wurde keines der 20 sklerosierten Gelenke bewertet. 

 

Tabelle 3 

Häufigkeiten der Lufteinschlüsse

199 61 70 52 382

52,1% 16,0% 18,3% 13,6% 100,0%

26 8 10 5 49

53,1% 16,3% 20,4% 10,2% 100,0%

12 4 4 0 20

60,0% 20,0% 20,0% ,0% 100,0%

237 73 84 57 451

52,5% 16,2% 18,6% 12,6% 100,0%

Anzahl

% von Code_cat

Anzahl

% von Code_cat

Anzahl

% von Code_cat

Anzahl

% von Code_cat

Kontroll
gruppe

Resorpt
ionen

Sklerosi
erungen

Code_cat

Gesamt

none poor moderate considerable

air (air cells)

Gesamt
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control group
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Abbildung 3.6: Pneumatisationsgrade innerhalb der K ontrollgruppe.  
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Abbildung 3.7: Pneumatisationsgrade innerhalb der R esorptionsgelenke. 
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Abbildung 3.8: Pneumatisationsgrade innerhalb der s klerosierten Gelenke. 
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3.5 Reproduktion der Z-Project-Methode 

 

Die Reliabilität der Z-Project Methode wurde durch den „Kendall-Tau-b-

Test“ überprüft. Getestet wurde die intra- und interindividuelle 

Reproduzierbarkeit. Der Umfang der Reproduktion betrug 20 Gelenke. Der 

Korrelationskoeffizient für die intraindividuelle Reproduzierbarkeit betrug 93,7 % 

(vgl. Tab. 4). Er errechnet sich aus einer ersten Messung (roofthickness 1) und 

der um sechs Monate versetzen zweiten Messung des gleichen Observers 

(roofthrep.). Der Korrelationskoeffizient zum Erhalt der interindividuellen 

Reproduzierbarkeit ergibt sich aus den unabhängigen Messungen zweier 

unterschiedlicher Observer (roofthickness 1 & roofthrep2). Dieser beträgt 91,6% 

(vgl. Tab.5). 

 

Tabelle 4 

Reproduktion der Z-Project-Methode (Intraobserver)

1,000 ,937**

. ,000

403 20

,937** 1,000

,000 .

20 20

Korrelationskoeffizient

Sig. (2-seitig)

N

Korrelationskoeffizient

Sig. (2-seitig)

N

roof thickness 1

roofthrep

Kendall-Tau-b

roof
thickness 1 roofthrep

Die Korrelation ist auf dem 0,01 Niveau signifikant (zweiseitig).**. 
 

 

 

Tabelle 5 

Reproduktion der Z-Project-Methode (Interobserver)

1,000 ,916**

. ,000

403 20

,916** 1,000

,000 .

20 20

Korrelationskoeffizient

Sig. (2-seitig)

N

Korrelationskoeffizient

Sig. (2-seitig)

N

roof thickness 1

roofthrep2

Kendall-Tau-b

roof
thickness 1 roofthrep2

Die Korrelation ist auf dem 0,01 Niveau signifikant (zweiseitig).**. 
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Abbildung 3.9: Grafische Darstellung der durchschni ttlichen roofthickness resulierend 

aus den Messungen der Studie, des Intraobservers un d des Interobservers.  

 

Der Mittelwert der Studienmessung lag bei 2,64mm. Das arithmetische Mittel 

der Reproduktion durch den Intraobserver betrug 2,55mm. Die Reproduktion 

der Z-Project-Methode durch den Interobserver betrug im Durchschnitt 2,45mm.
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4. Diskussion  

 

Bisher sind nur wenige Studien zu finden, die sich mit der Dicke des Daches 

der Fossa mandibularis beschäftigt haben. Nachfolgend werden die Validität 

der Z-Project-Methode und die durch sie erhaltenen Ergebnisse bezüglich der 

roofthickness mit der vorhandenen Literatur diskutiert. Da die Messwerte der 

einzelnen Studien nicht auf derselben Untersuchungsmethode basieren, sind 

die absoluten Werte nur bedingt miteinander in Zusammenhang zu setzen (vgl. 

Tabelle 6). Werden jedoch die jeweiligen Methoden mit ihren Regeln konstant 

eingehalten, können die daraus gewonnenen Daten innerhalb einer Studie in 

Relation gesetzt werden. Daraus gewonnene Aussagen lassen sich dann 

wiederum mit der vorliegenden Literatur diskutieren.  

 

4.1 Evaluation der Z-Project-Methode 

 

Die Z-Project-Methode ermöglicht, die roofthickness der Kiefergelenke über CT-

Bilder auf eine schnelle und kostengünstige Weise zu vermessen. Die 

Reliabilität der Methode wurde durch einen Intra- und Interobserver überprüft 

und erwies sich als sehr hoch. Der Kendall-Tau-b-Test errechnete für den 

Intraobserver einen Korrelationskoeffizienten von 93,7%, der Interobserver kam 

auf 91,6%.  

 

Anhand eines Durchführungsprotokolls (vgl. Kapitel 2.3.1) wird die Methode 

Schritt für Schritt erklärt und eine methodengerechte Anwendung gewährleistet. 

Somit ist es möglich, die bestehende Datenbank mit einer hohen Konstanz 

auch durch weitere Observer zu vergrößern und Aussagen zur roofthickness 

weiter zu präzisieren.  
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4.2 Mittelwerte der roofthickness (Kontrollgruppe) 

 

Tabelle 6 
Studie  Mittelwert  Standartabweichung  Methode  untersuchte Gelenke  

Honda I 1,37mm 0,72mm Schieblehre 42 

Honda II  1,22mm 0,63mm Computertomograph 42 

Honda III 0,6mm 0,25mm Schieblehre 61 

Tsuruta  0,7mm 0,12mm Computertomograph 24 

Matsumoto  0,85mm 0,31mm Computertomograph 70 

Greene 0,9mm k.A. Schieblehre                                 10 

Studie MS 3,16mm 1,5mm Computertomograph 365 
 

 

Für die roofthickness ergibt die Mittelwertberechnung aus den 365 untersuchten 

Gelenken, die keinen Anhalt für eine Pathologie gaben, einen Wert von 3,16 ± 

1,5 mm. In der Literatur findet man variable Angaben zu diesem Wert. HONDA, 

dessen Studie anhand von acht männlichen und 13 weiblichen Körperspendern 

durchgeführt wurde, gibt einen Mittelwert von 1,37 ± 0,72 mm bei einem 

Wertebereich von 0,55 - 3,7 mm an. Diese Werte basieren auf der Ermittlung 

durch eine digitale Schieblehre (Abb.1.7). In einer Reevaluation durch das 3DX 

System, wurden dieselben Patienten ein zweites Mal vermessen. Aus dieser 

Messung ergab sich ein Mittelwert von 1,22 ± 0,63 mm bei einem Wertebereich 

von 0,51 – 3 mm [19]. In einer weiteren Studie vermaß HONDA 30 männliche 

und 31 weibliche Gelenke erneut mit einer digitalen Schieblehre. Er ermittelte 

hierbei eine mittlere roofthickness von 0,6 ± 0,25 mm (Wertebereich: 0,2 – 1,5 

mm) [21]. TSURUTA [50] ermittelte durch einen Computertomographen aus 

einem Patientenfundus von 24 Gelenken eine mittlere roofthickness von 0,7 ± 

0,12 mm. MATSUMOTO [27] verwendete in einer Studie das 3DX System, das 

schon zuvor HONDA benutzte. Er gibt einen Mittelwert von 0,85 ± 0,31 mm an. 

Die Untersuchungen von GREENE [14] ergaben durchschnittlich 0,9 mm bei 

einem Werteintervall von 0,5 mm bis 1,5 mm. 
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Abbildung 4.1: Vergleich der in sieben unabhängigen  Studien durchschnittlich 
gemessenen roofthickness.  Mit einem Sternchen wurd en Studien gekennzeichnet, die 
mit einem Computertomographen gearbeitet haben. 
 

Der Mittelwert dieser Arbeit liegt mit 3,16 ± 1,5 mm deutlich über den Werten 

der Literatur. Gründe für diese Abweichung sind vor Allem durch die eigens 

konzipierten Regeln (Kapitel 2.3.1.2) zu erklären. Anhand eines Beispiels soll 

aufgezeigt werden, wie es zu dieser systematischen Abweichung kommt. 

 

 
Abbildung 4.2: Die Ausdehnung der kürzesten Strecke  zwischen den 
Tresholdmarkierungen beträgt bei einer HU von 1224 2,55 mm. 
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In Abb. 4.2 erkennt man, dass der Gelenkspalt zwischen Kondylus und dem 

knöchernen Fossadach nur unvollständig von dem Treshold markiert wurde. 

Der maximal markierte Grauwert beträgt in dieser Abbildung 1224 HU und sollte 

demnach alle nichtknöchernen Strukturen anfärben. Da dies in Abb. 4.2 mit 

dem Gelenkspalt offensichtlich nicht geschehen ist, wird auf eine Regel 

zurückgegriffen. Nach Regel 1 (Kapitel 2.3.1.2) wird die kürzeste Strecke 

zwischen den Markierungsgrenzen gemessen, wenn die Linie der „straight line 

selection“ in der ihr durch die Koordinaten vorgegeben Ausrichtung innerhalb 

der Thresholdmarkierung liegt. Dabei bleiben die Einstellungen des Thresholds 

unverändert. Die roofthickness beträgt in diesem Falle 2,55mm. Zum Vergleich 

soll präsentiert werden, wie sich die roofthickness verändert, wenn man den 

maximalen Grauwert des Thresholds bis zu dem Wert erhöht, bei dem der nicht 

knöcherne Gelenkspalt vollständig angefärbt wird (Abb. 4.3). Die roofthickness 

wäre hierbei mit einer Ausdehnung von 1,2mm nur halb so groß. 

 

 
Abbildung 4.3: Die HU wurden sukzessiv erhöht bis d er Gelenksspalt vollständig 
angefärbt ist. Die Ausdehnung der kürzesten Strecke  zwischen den Markierungen beträgt 
jetzt 1,2 mm. 

 

Diese Störfaktoren für die absoluten Werte der roofthickness konnten akzeptiert 

werden, weil für diese Studie die Reproduzierbarkeit von vorrangiger 

Bedeutung war. Es konnte mit Hilfe der Regeln der größte Patientenfundus aller 

themenverwandten Studien untersucht werden. Die stringente Methoden-
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konstanz ermöglichte ferner, dass die Ergebnisse innerhalb der Studie 

miteinander vergleichbar sind. Nach studieninterner Ausarbeitung konnten die 

daraus gewonnenen Erkenntnisse mit der Literatur diskutiert werden. 

 

Abweichungen in der absoluten roofthickness zwischen Auswertungen durch 

Computertomographen und den direkten Messungen am Knochen durch 

Schieblehren, wie sie HONDA beschreiben konnte [19], resultieren insbesondere 

aus dem „Partial-Volumen-Effekt“. Er ergibt sich bei Übergängen zwischen 

einzelnen Geweben und bei Läsionen, die kleiner sind als die Schichtdicke des 

CT-Bildes. Um den unerwünschten Effekt zu minimieren, sollte man die 

Schichtdicke des Bildes minimieren [25].  

 

 
Abbildung 4.4: Grafische Darstellung des Partial-Vo lumen-Effekts. Die erste Reihe zeigt 

das Originalobjekt. In der zweiten und dritten Reih e werden die Darstellungen des 

Objektes über das CT-Bild bei 8mm bzw. 2mm Schichtd icke dargestellt. 
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4.3 Abhängigkeiten der roofthickness 

 

4.3.1 Alter und Geschlecht (Kontrollgruppe) 

 

Bisher wurde nur in einer weiteren Arbeit [20] die roofthickness in Abhängigkeit 

vom Alter und vom Geschlecht untersucht. Dazu wurden 49 Fossadächer von 

85 Verstorbenen ausgewählt und mit Hilfe eines digitalen Mikrometers an ihrer 

dünnsten Stelle vermessen. Das Patientengut verteilte sich nahezu gleichmäßig 

auf Männer und Frauen. Das Alter lag zwischen 50 und 96 Jahren, wobei das 

Durchschnittsalter 73,8 Jahre betrug. Die aus der Studie gewonnenen 

Ergebnisse konnten keine Korrelation zwischen Geschlecht und Alter mit der 

roofthickness zeigen [20]. 

 

In der vorliegenden Studie konnte mit 365 untersuchten Gelenken ein deutlich 

größeres Patientengut und ein erweiterter Altersbereich (16-80 Jahre) 

ausgewertet werden auf. Die Ergebnisse der Studie HONDAS, die keine 

signifikanten Korrelationen zwischen dem Alter und dem Geschlecht ergeben 

hatte, konnten durch die vorliegende Studie bestätigt und erweitert werden. 

 

4.3.2 Gelenkseite (Kontrollgruppe) 

 

In der Literatur wurde bisher nicht beschrieben, ob es Unterschiede der 

roofthickness zwischen den Gelenkseiten gibt. Unsere Ergebnisse besagen, 

dass das arithmetische Mittel der Gesamtheit der linken Gelenke hoch 

signifikant (p = 0,01) über dem der Gesamtheit der rechten Gelenke liegt. Über 

Gründe für diesen hoch signifikanten Unterschied kann nur spekuliert werden. 

Eventuell gibt es einen Zusammenhang zwischen der roofthickness und der 

bevorzugten Kauseite der Patienten. Als Kauschlaufe bezeichnet man den Weg, 

den ein unterer Arbeitshöcker während des Kauaktes vollzieht. Dreidimensional 

betrachtet gleitet der Höcker zuerst leicht nach medial, schwingt dann nach 
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lateral distal um dann wieder in die antagonistische Fossa gezogen zu werden.  

Damit es zu der beschriebenen lateralen Versetzung des Unterkiefers zur 

Arbeitsseite kommen kann, muss der Musculus pterygoideus lateralis der 

Gegenseite kontrahieren. Durch die Kontraktion wird der Kondylus der 

Balanceseite vorverlagert und auch das viskoelastische Gewebe gedehnt. In 

Anlehnung daran soll auf die in Kapitel 1.1.3.2 beschriebene „growth relativity 

Theorie“ verwiesen werden, die die Vorverlagerung und die Dehnung des 

viskoelastischen Gewebes als die Hauptstimuli für Knochenapposition im 

Bereich des Kondylus und der Fossa angibt [52]. Folglich ist es anzunehmen, 

dass auch der Kauakt einen funktionellen Faktor für das Wachstum der Fossa 

mandibularis und damit auch auf die roofthickness darstellt. Um dies weiter zu 

verifizieren, könnte man in nachfolgenden Studien versuchen, die bevorzugte 

Kauseite über Abrasionsgrade der Zahnreihen zu lokalisieren und sie in 

Verbindung mit der roofthickness zu stellen.  

 

4.3.3 Resorptionen und Sklerosierungen  

 

Unsere Studie ergibt für die Studiengruppe „resorption“ die kleinste mittlere 

roofthickness. Dies jedoch ist konträr zur der Schlussfolgerungen, die sich aus 

der „growth relativity“ ableiten lässt (vgl. Kapitel 1.3.2). Die „growth 

relativity“ besagt, dass sich das Wachstum der Fossa relativ zu der Verlagerung 

des Kondylus verhält und dass nach Änderung der Kondylus-Fossa-Relation, 

beide Komponenten bestrebt sind, ihr pysiologisches Ausmaß wieder 

anzunehmen [52]. In der dazugehörigen Studie von VOUDOURIS wurde der 

Kondylus mit Hilfe von kieferorthopädischen Geräten aus der Fossa 

herausgezogen. So gesehen wurde also der Anteil des Kondylus innerhalb der 

Gelenkgrube verkleinert und die physiologische Kondylus-Fossa-Relation 

beeinflusst. Ebenso wird die Relation verändert bei Sklerosierungen und 

Resorptionen, die eine relative Massenzunahme (Sklerosierungen) bzw. relative 

Massenabnahme (Resorptionen) des Kondylus mit sich ziehen. 
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Folglich erwartet man nach der „growth relativity“ eine Knochenapposition der 

Fossadächer bei resorbierten beziehungsweise Knochenresorptionen bei 

sklerosierten Kondylen. 

 

Dass diese Hypothese anhand unserer Daten nicht bestätigt werden konnte, 

liegt wahrscheinlich zu einem Großteil an unserer eigenen Definition für 

„resorption“ und „sclerosis“ (Kapitel 2.2.1.2 bzw. 2.2.1.3). Wir orientierten uns 

bei der Definition nicht an dem Krankheitsbild, sondern an der Kondylus-Fossa-

Relation. Somit gibt es Fälle, die mit „resorption“ bezeichnet wurden, obwohl sie 

einen stark sklerosierten Kondylus zeigen, der aber aus der Fossa 

herausgewandert ist und somit die Kondylus-Fossa-Relation trotzdem 

verkleinert hat. Ein extremes Beispiel für diesen methodischen Fehler wird in 

Abbildung 4.5 präsentiert. Es zeigt sich ein außergewöhnlich stark vergrößerter 

Kondylus, der sich weit von seiner physiologischen Fossaposition nach kaudal 

und anterior des Tuberculum articulare positioniert hat. 

 

 
Abbildung 4.5: Der Kondylus ist unphysiologisch auß erhalb seiner Fossa positioniert. 
Daher nimmt trotz des hyperplastischen Kondylus die  Kondylus-Fossa Relation ab.   
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4.4 Vorkommen von Lufteinschlüssen 

 

Aus unseren Ergebnissen ist zu folgern, dass nahezu die Hälfte der von uns 

bewerteten Gelenke Pneumatisationen im Dach der Fossa mandibularis 

enthielten. Bezogen auf die einzelnen Pneumatisationsgrade verhielten sich die 

Kontrollgruppe und die Gruppe der Resorptionen ähnlich. In der Gruppe der 

Sklerosierungen waren insgesamt weniger Pneumatisationen zu betrachten. 

Diese Ergebnisse korrelieren mit den Aussagen von STAMM [48]. Er behauptet, 

dass die Fossa in der Lage ist, relativ zeitnah auf Änderungen der 

physiologischen Kondylus-Fossa-Relation durch Knochenneubildungen bzw. 

Knochenresorptionen zu reagieren. Deshalb modelliert der Knochen als 

Reaktion auf eine Kondylusresorption zunächst primär ein Leitgerüst, in das 

nicht kalzifizierte Bereiche mit eingeschlossen werden. Im Umkehrschluss muss 

das Gelenk auf einen sklerosierten Kondylus mit einer Resorption der 

Gelenkpfanne reagieren. Die Knochenstruktur zwischen Fossa mandibularis 

und Fossa cranii media wird dabei zunehmend dünner und Pneumatisationen 

müssen durch Hartsubstanz zur Stabilisierung ersetzt werden. 

 

4.5 Schlussfolgerung 

 
Schlussfolgernd lässt sich sagen, dass die Z-Projekt-Methode zur Erlangung 

der roofthickness eine reliable und einfache Methode ist. Dennoch sollte sie 

nicht zur Ermittlung absoluter Werte für die roofthickness angewendet werden. 

Die ermittelten Werte sollten vielmehr relativ gesehen und in Verbindung mit der 

Literatur ausgewertet werden. Der große Vorteil dieser Methode ist, dass man 

sich aus Archiven jeglicher CT-Aufnahmen bedienen kann, die das Kiefergelenk 

darstellen. Somit ist es möglich, ein umfangreiches und ausgeglichenes 

Patientenkollektiv zu untersuchen. Dies scheint von besonderer Bedeutung zu 

sein, da sich bisher nur wenige Studien mit geringen Patientenzahlen dem 

Thema der roofthickness angenommen haben.  
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Ergebnisse dieser Studie können vor allem die vorhandene Literatur in ihren 

Aussagen stützen und Tendenzen in neuen Untersuchungsgebieten aufzeigen. 

Um diese Tendenzen, besonders denen im Bereich der gelenksseiten-

abhängigen roofthickness und der funktionsabhängigen Pneumatisation 

innerhalb des Kiefergelenkes, weiter zu verifizieren, sollten diese Themen in 

folgenden Studien aufgegriffen und mit Hilfe neuer Methoden untersucht 

werden. 
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5. Zusammenfassung 

 

Das Kiefergelenk (Articulatio temporomandibularis) nimmt aufgrund seiner 

speziellen Morphologie eine besondere Stellung unter den Gelenken ein. Für 

alle Disziplinen der Zahnheilkunde ist es von großem Interesse, wie sich das 

Gelenk auf funktionelle Einflüsse hin verhält. Stellvertretend für die Adaptations-

vorgänge des Gelenkes wird die Knochendicke zwischen Fossa mandibularis 

und der Fossa cranii media vermessen und auf Abhängigkeiten überprüft.  

 

Anhand der frei zugänglichen Bildbearbeitungssoftware ImageJ wurde eine 

Methode entwickelt mit der sich das Dach der Fossa mandibularis an seiner 

dünnsten Stelle (roofthickness) anhand von Computertomographie-Datensätzen 

lokalisieren und vermessen lässt. Regeln wurden aufgestellt um ein konstantes 

Verfahren zu ermöglichen. 

 

Das Patientenkollektiv enthielt 219 männliche und 232 weibliche Gelenke. 

Diese wurden je nach Befund in drei Gruppen eingeteilt. 49 Gelenke zeigten 

resorptive Veränderungen und wurden der Gruppe „resorption“ zugeteilt. 

Sklerosierugen traten bei 20 Gelenken auf. Sie bildeten die Befundgruppe 

„sclerosis“. Den beiden genannten Gruppen wurde die Kontrollgruppe 

„control“ mit 382 Gelenken gegenübergestellt. Sie zeigten keinerlei patho-

logische Kiefergelenksveränderungen.  

 

Die Reliabilität der Z-Project Methode wurde durch einen Intra- und 

Interobserver anhand von 20 zufällig ausgewählten Gelenken überprüft. Die 

intraindividuelle Reproduktion ergab 93,7%. Die interindividuelle Reproduktion 

91,6%. 

 

Bezüglich der roofthickness konnte eine signifikante Abhängigkeit von der 

Gelenkseite herausgestellt werden. Abhängigkeiten zwischen dem Alter, dem 

Geschlecht und den Befundgruppen konnten nicht nachgewiesen werden. Die 
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durchschnittliche roofthickness der Studie beträgt 3,2 mm ± 1,5. Das 

Werteintervall erstreckt sich von 0 mm bis 8,5 mm. 

 

Zusätzlich wurden Gelenke mit Lufteinschlüssen innerhalb des Daches der 

Fossa mandibularis, über deren Ätiologie in verschiedenen Arbeiten spekuliert 

wird, in vier Gruppen „none“, „poor“, „moderate“, und „considerable“ nach dem 

Ausmaß ihrer Pneumatisationen eingeteilt. 

 

Aus den ausgewerteten Daten lassen sich nachstehende Schlussfolgerungen 

ziehen: 

 

• Die Z-Project Methode hat sich als ein sehr reliables Verfahren zur 

Ermittlung der roofthickness bewährt.  

 

• Eine Ermittlung absoluter Werte ist mit dieser Methode jedoch 

nicht möglich. Sie müssen zunächst relativ interpretiert und dann 

in Verbindung mit der Literatur ausgewertet werden.  

 

• Zur roofthickness in Verbindung mit dem Alter, dem Geschlecht 

und der Befundgruppen konnten die Ergebnisse 

vorausgegangener Studien untermauert werden. Bezüglich der 

Abhängigkeit der roofthickness von der Gelenkseite konnte eine 

bisher nicht entdeckte Feststellung gemacht werden. 

 

• Zudem konnte tendenziell gezeigt werden, dass das Kiefergelenk 

auf funktionelle Einflüsse mit der Bildung von pneumatisierten 

Knochen reagiert.  
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